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Content Summary 
System access 
• What is my username?  
• What is my password?  
• How do I login?  
• How do I change my password? 
• Forgot my password  
• Logging out 
• What  software are needed to access the system  
• Will using the system alter my computer in any way  

Account Configuration and Settings 
• Add staff user  
• Editing account settings  
• Editing the settings of other staff users  
• Update my organization's information  

System Support 
• Access the online help system  
• Download the help guides  
• Contacting customer/technical support  
• Report a problem with the system  
• Provide feedback/suggestions  
• View the Forums  

Vendor Management 
• Search for a vendor  
• Verify vendor certification 
• Add a new vendor to the system  
• Edit the contact information for a vendor  
• Edit/add authorized users to a vendor  
• List of ALL joint ventures and owners  
• Locate owners of a particular joint venture  
• Edit/add joint venture owners to a vendor  
• Contacting a business through the system  

Contracts 
• Find a specific contract  
• View a list of my contracts  
• View a contract  
• Add a new subcontractor to a contract  
• Edit a subcontractor of a contract  
• “Unlock” a subcontractor that has designated “Final 

Payment” made  
• View the audit for a particular time period  
• Edit/enter the subcontractor payment amount on a contract 

for a particular time period  
• Bulk enter subcontractor payment data for a particular time 

period  
• View the payment summary for a contract  

• View the prime contractor’s payment for a contract  
• View a subcontractor’s payment history for a contract  
• View all contracts assigned to a prime contractor or 

subcontractor  
• Post an amendment/change order to the contract  
• Resolve an audit discrepancy  
• Extend the reporting deadline on an audit  
• Approve or deny a subcontractor addition request  
• Close out a contract  

Concessions 
• Find a specific concession  
• View a list of my concessions  
• Add a new location/subtenant  to a concession  
• Edit a location/subtenant of a concession  
• Add a new supplier to a concession  
• Edit a supplier of a concession  
• View the audit for a particular time period  
• Edit/enter the revenue amount on a concession for a 

particular time period  
• Bulk enter revenue data for a particular time period  
• Edit/enter the expenditure amount on a concession for a 

particular time period  
• Bulk enter supplier payment data for a particular time period  
• View the revenue and/or payment summary for a concession  
• View a location’s revenue history for a concession  
• View a supplier’s payment history for a concession  
• View all concessions assigned to a concessionaire, 

subtenant, joint venture partner, or supplier  
• Close out a concession  

Outreach 
• Create a new outreach project  
• Configure my project settings  
• Create or edit the content of my project  
• Add vendors to my vendor list  
• View my projects 

General 
• Send a message to another user  
• Run a report  
• Formats of report output 
• Search for other users  

Security 
• Is the system secure? 
• Is my data protected?  
• Can others access my account?  
• Can others access my data?  
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System Access 

What is my username? 
Your username is your email address. 

What is my password? 
Your password is initially assigned to you.  You must change it to something only you know the first time you 
login. 

How do I login? 
1. Open your Internet browser. 
2. In the System Access Login box, enter your username and password. 
3. Click Login. 

How do I change my password? 
From the Edit Settings menu: 
1. Click Change Password. 
2. In the Old Password field, type your old password. 
3. In the New Password and Type New Password Again fields, type your new password. 
4. Click Save. 
5. Your new password is effective immediately. 

What do I do if I forget my password? 
From the system home page: 
1. In the System Access Login box, click the Forgot Password link. 
3. Enter your email address, username, or user number (format: ########-###) in the field and click 

Submit. 
4. An email and/or fax username/password reminder will be sent to you within minutes. 

How do I log out? 
1. From the left menu, at the bottom, click Log Off. 
2. Click OK in the pop-up alert. 

What types of software are needed to access the system? 
All you need to access the system is a standard Internet browser.  Internet Explorer works best. 

Will using the system alter my computer in any way? 
No, the system will leave no trace on your computer other than standard Internet browser history and cache files.  
You can delete these files at any time using your browser's options/preferences menu option.  The system does 
not use "cookies" or any other form of recorded file. 
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Account Configuration and Settings 

How do I add another staff user? 
From the Edit Settings menu: 
1.  Click Add New User.  
2. Fill in each field, clicking Next to continue. 
3. Mark or unmark the checkbox option to send a password to the user. 
4. Click Save to complete. 
Note: While adding a user, do NOT click the Back button of your browser.  If you do, you will have to start the process 
from the beginning. 

How do I edit my own account settings? 
From the Edit Settings menu:  
1. Click Your Settings. 
2. Select an option link. 
3. Complete your changes. 
4. Click Save to complete. 

How do I edit the settings of other staff users? 
From the Edit Settings menu: 
1. Click User List. 
2. Click the name of the user you would like to edit. 
3. Edit the settings.  
4. Click Save to complete. 

How do I update my organization's information? 
From the Edit Settings menu: 
1. Click Org Info. 
2. Select a option link. 
3. Complete your changes. 
4. Click Save to complete. 
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System Support 

How do I access the online Help System? 
From the Help & Support menu:  
1. Click Help System. 
NOTE: The Help System is also available by clicking any of the blue question mark icons throughout the system. 

How do I download the Help Guides? 
From Help & Support menu:  
1. Click Help Guides. 
2. Select the Guide you would like to open. 
3. Click the Save Icon in the PDF viewer. 

How do I get help from customer/technical support? 
From the Help & Support menu: 
1. Click  Contact Support. 
2. Click on the check box for the recipient. 
3. Enter the Subject and your message.   
4. Click Submit. 

How do I report a problem with the system? 
From the Help & Support menu: 
1. Click Report a Problem. 
2. Enter your problem in the provided fields.  
3. Click Submit. 
NOTE:  Attach screenshots, including error messages for clarification. 

How can I provide feedback/suggestions? 
From the Tools menu: 
1. Click Messaging. 
2. Click Submit Feedback. 
2. Enter your feedback. 
3. Click Submit. 

How can I view the Forums? 
From the Help & Support menu: 
1. Click Forums. 
2. Click the title of the forum. 
3. Click on the title of the topic you would like to view. 
NOTE: A yellow arrow indicates new or unread posts. 
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Vendor Management 

How do I search for a Vendor? 
From the Search menu: 
1. Click Vendors. 
2. Enter search parameters.  
3. Click Search First 20 Matches. 

How do I verify that a vendor is certified? 
From the vendor search results: 
1. Click Certs  in the Actions column. 
NOTE: If the firm is currently certified, the certification information will be listed in the Current Certifications box. 

How do I add a new vendor to the system? 
From the Tools menu: 
1.  Click Add a Vendor. 
2. Fill in the vendor information.  
NOTE: The more information you enter, the better your reporting will be. 
3. Click Review . 
4. The system will perform a search to determine if the vendor is already in the system. 

• Red alert box: The system found an exact match.  The vendor record cannot be saved. 
• Yellow alert box: One or more pieces of information matched a vendor already in the system.  It 

may or may not be an exact match.  The vendor record may be saved. 
• No alert box: The firm does not exist.  Create a new vendor account. 

NOTE: Depending upon the new firm notification setting, the system may send a username/password notification to their 
email address and/or fax number. 

How do I edit the contact information for a vendor? 
From the vendor search results: 
1. Click the Edit link in the Actions column. 
2. Click the General Info tab. 
3. Updated the vendor information. 
4. Click Save Changes 

How do I add authorized users to a vendor account? 
From the vendor search results: 
1. Click the Edit link in the Actions column. 
2. Click the Users tab. 
3. Click Add User.  
4. Enter the user’s information and settings. 
5. Click Save to complete. 
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How do I edit authorized users to a vendor account? 
From the vendor search results: 
1. Click the Edit link in the Actions column. 
2. Click the Users tab. 
3. Click on their name. 
4.  Update the information. 
5. Click Save to complete. 

Where do I find a list of ALL joint ventures and owners? 
From the Reporting Tools menu: 
1. Click Run/Queue Report. 
2. Click View Complete Reports List. 
3. Click Concessions: Joint Venture Owners. 
Refer to How do I run a report? in the General section 
NOTE:  The report is available only to organizations that use the Concessions module. 

Where do I find the owners of a particular joint venture? 
From the vendor search results:  
1. Click the Edit link in the Actions column. 
2. Click the Contacts & Owners tab. 
3. View Owners box to see owners currently assigned to this joint venture. 

How do I edit joint venture owners to a firm? 
From the Contacts & Owners tab: 
1. View Owners box to see owners currently assigned to this joint venture. 
2. Click Edit link in the Actions column. 
3. Update the information. 
4. Click Save to complete. 

How do I  add joint venture owners to a firm? 
From the Contacts & Owners tab: 
1. View Owners box to see owners currently assigned to this joint venture. 
2.  Click Add Owner below the box. 
3. Complete the form. 
4. Click Save to complete. 

How can I contact a business through the system? 
From the user search results:  
1. Click the Email link in the Actions column. 
2. Compose your message in the space provided. 
3. Click Save to complete. 
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Contracts 

How do I find a specific contract? 
From the Search menu: 
1. Click Contracts. 
2. Enter the contract number in the first field, or fill in/select other parameters. 
3. Click Search all Matches. 

How do I view a list of my contracts? 
From the Search menu: 
1. Click Contracts. 
2. In the Contract Compliance Officer field, select your name. 
3. Click Search all Matches. 

How do I view a contract? 
From the contract search results: 
1. Click the contract number or the name of the contract. 

How do I add a new subcontractor to a contract? 
From the Contract Management page:  
1. Click the Subcontractors tab. 
2. Click Add Subcontractor. 
3. Fill in the form. 
4. Click Review to verify the information. 
5. Click Save to complete. 

OR 
From the contract search results, 
1. Click the Subs link in the Actions column. 
2. Click Add Subcontractor. 
3. Fill in the form. 
4. Click Review to verify the information. 
5. Click Save to complete. 

How do I edit a subcontractor of a contract? 
From the Contract Management page: 
1. Click the Subcontractors tab. 
2. Click Edit in the Action column for the subcontractor. 
3. Edit the necessary information. 
4. Click Review to verify the information. 
5. Click Save to complete. 
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How do I “unlock” a subcontractor that has designated “Final Payment” made? 
From the Contract Management page: 
1. Click the Subcontractors tab. 
2. Click Edit in the Action column for the subcontractor. 
3. Change Yes to No, in the Final Payment Made? Field. 
4. Click Review to verify the information. 
5. Click Save to complete. 

How do I view the audit for a particular time period? 
From the Contract Management page:  
1. Click the Audit List tab. 
2. Click View Audit link in the Actions column, for the particular time period. 

How do I edit/enter a subcontractor payment on a contract for a particular time period? 
From an audit for a particular time period, in the Audit Subcontractor Details box: 
1. Click the Edit link in the This Period column. 
2. Enter the amount paid for the time period. 
3. Click Review to verify the information. 
4. Click Save to complete. 

How do I bulk enter subcontractor payment data for a particular time period? 
From an audit for a particular time period: 
1. Click Submit ALL Incomplete Records. 
2. Enter the amounts in the form. 
3. Click Review to verify the information. 
4. Click Save to complete. 

How do I view the payment summary for a contract? 
From the Contract Management page: 
1. Click the Audit Summary tab.  
OR 
From the contract search results:  
1. Click the Audit link in the Actions column. 

How do I view the prime contractor’s payment history for a contract? 
There are three ways to access the prime contractor’s payment history: 

From the Audit Summary tab: 
1. Click the Payment History link. 
From an audit for a particular time period: 
1. In Audit Summary, click the Payment History link. 
From the Subcontractors tab, in the Prime Contractor box: 
1. Click the Payments link in the Actions column. 
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How do I view a subcontractor’s payment history for a contract? 
There are three ways to access the subcontractor’s payment history: 

From the Audit Summary tab: 
1. Click the on the name of the subcontractor. 
From an audit for a particular time period: 
1. Click the name of the subcontractor in the Audit Subcontractor Details box. 
From the Subcontractors tab: 
1. Click the Payments link in the Actions column for the subcontractor. 

How do I view all contracts assigned to a prime contractor or subcontractor? 
From the Search menu:  
1. Click Vendors. 
2. Enter the name of the firm.  
3. Click Search All Matches. 
4. Click the Contracts link in the Actions column of the vendor you selected. 

How do I post an amendment/change order to the contract? 
From the Contract Management page: 
1. Click the Amend Contract link in the Contract Status & Actions box. 
2. Complete the Amendment information and contract information. 
3. Click Review to verify the information. 
4. Click Save to complete. 
NOTE:  If the contract has subcontracts, you will be required to note any changes to the contracted percentages. 

 How do I resolve an audit discrepancy? 
To access information about the discrepancy, and information provided by the prime and subcontractor 

From an audit for the particular time period: 
1. Click Resolve under the red Discrepancy alert in the Confirmed By Sub field. 
1. Review the information and communicate with the parties to determine and resolve the situation. 
2. Click Resolve Discrepancy on the Discrepancy Resolution page when the final data is available. 
3. Enter the Final Reported Amount.  
4. Click Review to verify the information. 
5. Click Save to complete. 

How do I extend the reporting deadline on an audit? 
To extend the reporting period for one particular audit: 

From an audit for a particular time period: 
1. Click Extend Reporting Deadline By Two Weeks From Today. 

To extend the reporting period for all audits on the contract: 
From the Contract Management page: 
1. Click the Audit List tab. 
2. Click Extend Reporting Deadline By Two Weeks From Today at the bottom of the page. 
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How do I approve or deny a subcontractor addition request? 
From the Contract Management page:  
1. Click the Subcontractors tab.   
2. Click the View  in the Subcontractor Addition Requests box at the bottom of the page. 
3. Review the request. 
4. Click Approve Request or Deny Request at the bottom of the page. 
NOTE:  If you are not authorized to take action, your recommendation will be recorded and the request will remain open. 
5. Confirm the data. 
6.  Save the subcontractor. 

OR 
From the View menu:  
1. Click Sub Addition Requests.   
2. Click on the Subcontractor name. 

How do I close out a contract? 
From the Contract Management page: 
1. Click the Contract Close tab. 
2. Click Close Out Contract. 
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Concessions 

How do I find a specific concession? 
From the Search menu:  
1. Click Concessions. 
2. Enter the concession number in the first field, or fill in/select other parameters. 
3. Click Search All Matches. 

How do I view a list of my concessions? 
From the Search menu:  
1. Click Concessions. 
2. In the Concession Compliance Officer field, select your name. 
3. Click Search All Matches. 

How do I view a concession? 
From the contract search results: 
1. Click the contract number or the name of the contract. 

How do I add a new location/subtenant to a concession? 
From the Concession Management page: 
1. Click the Concession Locations tab. 
OR 
From the concession search results:  
1. Click the Locations link in the Actions column. 
2. Click Add Location/Subtenant. 
3. Complete the form. 
4. Click Review to verify the information. 
5. Click Save to complete. 

How do I edit a location/subtenant of a concession? 
From the Concession Management page: 
1.  Click the Concession Locations tab.  
2. Click Edit in the Action column for the location/subtenant. 
OR 
From the concession search results: 
1. Click the Locations link in the Actions column. 
2. Click Edit in the Action column for the location/subtenant. 
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How do I add a new supplier to a concession? 
From the Concession Management page: 
1.  Click the Suppliers tab. 
2. Click Add Supplier. 
3. Click the Get Vendor. 
4. Search for the vendor. 
5. Click Select User in search results. 
6. Complete the form. 
7. Click Review to verify the information. 
8. Click Save to complete. 
OR 
From the concession search results: 
1. Click the Suppliers link in the Actions column. 
2. Follow steps 2-8 from above. 

How do I edit a supplier of a concession? 
From the Concession Management page: 
1.  Click the Concession Locations tab.  
2. Click Edit in the Action column for the location/subtenant. 
OR 
From the concession search results: 
1.  Cick the Locations link in the Actions column. 
2. Click Edit in the Action column for the location/subtenant. 

How do I view the audit for a particular time period? 
From the Concession Management page:  
1. Click the Audit List tab. 
2. Click View Audit link in the Actions column for the particular time period. 

How do I edit/enter the revenue amount on a concession for a particular time period? 
From an audit for a particular time period: 
1. click the Edit in the Audit Revenue (Location/Subconcessionaire) Details box. 
2. Enter the amount paid for the time period. 
3. Click Review to verify the information. 
4. Click Save to complete. 

How do I bulk enter revenue data for a particular time period? 
From an audit for a particular time period: 
1. Click Submit ALL Incomplete Location Records button above the Audit Revenue 

(Location/Subconcessionaire) Details box. 
2. Enter the amounts. 
3. Click Review to verify the information. 
4. Click Save to complete 
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How do I edit/enter the expenditure amount on a concession for a particular time 
period? 

From an audit for a particular time period: 
1. Click the Edit in the Audit Expenditure (Supplier) Details box. 
2. Enter the amount paid for the time period. 
3. Click Review to verify the information. 
4. Click Save to complete. 

How do I bulk enter supplier payment data for a particular time period? 
From an audit for a particular time period: 
1. Click Submit ALL Incomplete Location Records. 
2. Enter the payment information. 
3. Click Review to verify the information. 
4. Click Save to complete. 

How do I view the revenue and/or payment summary for a concession? 
From the Concession Management page: 
1. Click the Audit Summary tab. 
OR  
From the concession search results: 
1. Click the Audit link in the Actions column. 

How do I view a location’s revenue history for a concession? 
There are three ways to access a location’s revenue history. 

From the Audit Summary tab:  
1. Click the name of the Location/Subtenant. 
From an audit for a particular time period: 
1. Click the name of the Location/Subtenant in the Audit Revenue (Location/Subconcessionaire) Details 

box. 
From the Locations tab:  
1. Click the Revenues in the Actions column for the Location/Subtenant. 

How do I view a supplier’s payment history for a concession? 
There are three ways to access a supplier’s payment history. 

From the Audit Summary tab:  
1. Click the name of the Location/Subtenant. 
From an audit for a particular time period: 
1. Click the name of the Location/Subtenant in the Audit Expenditure (Supplier) Details box. 
From the Suppliers tab:  
1. Click the Payments link in the Actions column for the Location/Subtenant. 

How do I view all concessions assigned to a concessionaire, subtenant, joint venture 
partner, or supplier? 
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From the Search menu: 
1. Click Vendors. 
2. Enter the name of the vendor.  
3. Click Search. 
4. Click the Concessions link in the Actions column. 

How do I close out a concession? 
From the Concession Management page: 
1. Click the Concession Close tab. 
2. Click Close Out Concession. 
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Outreach 

How do I create a new Outreach Project? 
From the Create menu: 
1. Click New Project.  
2. Fill out Outreach Project Parameters. 
3. Click Create Project. 
4. Click Okay on the pop-up alert to continue. 

How do I configure my project settings? 
From the Outreach Project Management page:  
1. Click the Settings tab. 
2. Select your settings. 
3. Click Save to complete. 

How do I create or edit the content of my project? 
From the Outreach Project Management page:  
1. Click the Content tab. 
2. Click Edit. 
3. Enter or edit your text in each section. 
4. Click Save to complete. 

TIP:  Use the Spell Check button to double check your content. 

How do I add vendors to my vendor list? 
From the Outreach Project Management page:  
1. Click the Vendor List tab. 
2. Click on Add Vendors. 
3. Fill in your search parameters. 
4. Click on Search All Matches. 
 
From the search results: 
5. Click Add to Outreach. 
6. Select your project and click Add Vendors to Project. 
7. Repeats step 2-5 to add more vendors. 
8. Use the checkboxes to select the vendors you do not want to include. 
9. Click Delete at the top of the column. 

How do I view my projects? 
From the View menu:  
1. Click Outreach Projects 
2. Click on the title to view 
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General 

How do I send a message to another user? 
From the Message menu: 
1. Click Send a Message. 
2. Enter your message  
3. Click Review to verify your message. 
4. Click Send to complete 

NOTE: The recipient is notified by e-mail or fax that a message has been sent. The notification method depends on the 
recipient's settings. The message, and any attachments, can also be accessed after the recipient logs on to the system. 

How do I search for other users? 
From the Search menu: 
1. Click Users. 
2. Enter search parameters. 
3. Click Search.  

NOTE:  If no matches were returned, you can modify the search by clicking Search Again. 

How do I run a report? 
To queue a report to run 

From the Reporting Tools menu: 
1. Click Run/Queue Report. 
2. Click the title of the report you would like to run. 
3. Select the desired parameters. 
4. Click Run Report. 

Viewing a report 
From the Reporting Tools menu: 
1. Click View Report Output. 
2. Click the Ready to View link in the Status column for the report you want to view.  

NOTE: If the Status indicates Pending, it is not ready for viewing. 

3. Select a Report Output Format. 
4. Click View Report Output. 

Formats of report output 
There are several report output formats that can be used. 
Webpage (HTML) 

The report output will be displayed in a new Internet browser window as a web page. Some reports may 
display multiple tables of data.  This format is best for quickly viewing transaction and system information. 

Microsoft Excel (XLS) 
The report output will be display in a new Internet browser as a Microsoft Excel spreadsheet. 

NOTE:  There is a known issue with Microsoft Excel 2000 that prevents a downloaded Excel file from being saved to your hard 
drive.  This is usually due to the file being opened in your Internet browser.  You may also be prompted for a username and 
password.  If you have this version of Excel, it is suggested that you use the Comma delimited (CSV) format, as it ignores the 
Internet browser when opening the file and sends the file directly to Excel. 
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Comma delimited (CSV) 
The report output will be formatted in a manner that divides the data using commas.  A File Download box 
will be displayed asking you to Open the report results in viewer (such as Microsoft Excel), or Save the 
results to a .csv file (which can be opened from your hard drive using Microsoft Excel). 

TIP:  This is the best format if you wish to sort, filter, and edit the data for printing or distribution. 

Raw text (TXT) 
The report output will be formatted and output directly to a text file.  A File Download box will be displayed 
asking you to Open the report results in a text viewer, or Save the results to a text file.  This format is used 
for downloads of data that are to be loaded into older database systems. 

XML 
The report output is converted to XML format in a new Internet browser window.  This format is used for 
downloads of data that are to be loaded into newer database systems that are configured to interpret the 
XML output. 

Tips to use in searches 
Good search technique is critical to efficient use of the system. 

• Start with one parameter.  Usually one, a sometimes two parameters, is sufficient to find the record you 
are looking for.  The more specific your search terms, the more likely the record will not match the terms 
due to spelling, order, or other variations. 

• Keep the search parameters short.  Use ACME instead of ACME Construction, Inc.  You can even use 
partial words, such as envi instead of typing environmental consultant. 

• The system will ignore punctuation.  C & C is treated the same as C and C; C. C. is the same as C C. 
• When searching for businesses that are named for their founder, such as John Smith & Co., it may be 

listed as John Smith and Co. or Smith, John and Co.  You may need to search for both versions.  Start 
by searching just for one of the names, such as Smith. 

• Become familiar with the possible settings and options.  The record you are seeking may not be displayed 
because you have selected the wrong option.  Or too many records were returned because you did not 
narrow the search parameters. 

• The search is not case sensitive.  ACME is treated the same as acme. 
• When searching by first name, be aware that users may be listed by alternate names.  For example: 

James, Jim, Jimmy, or J. 
• When searching by contract or project number, where you are typing a specific reference, your number 

must be exactly correct.  It does not have to be complete (type C53 to view all contracts that have C53 in 
the contract number, such as C531, C532, C53B, C53980 etc.), but C53 will not find C35. 
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Security 

Is the system secure? 
The system is extremely secure.  When you log in, you are assigned a unique, temporary identifier.  The identifier 
will expire within four hours.  Using the system will refresh the expiration of the identifier, so that you can continue 
your work.  When you are finished, we recommend logging out before you close your Internet browser.  This will 
delete the identifier, preventing someone from using your computer to gain access to your account. 

Is my data protected? 
Your data is protected all of the time.  It is stored on top-of-the-line servers that are protected by multiple 
hardware and software firewalls.  Confidential data is protected by industrial-strength encryption. 

Can others access my account? 
No other users can access your account.  Your username and password are unique.  NEVER give these to any 
one else.  If someone in your organization requires access to the system, you can set up a new account for them. 

Can others access my data? 
Other users in your organization can see the same information as you, depending upon their access settings.  
Vendors can view only select information on contracts, concessions, and certifications. 


